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          2.11 Suggested Readings 

2.1 Introduction 
Modern spreadsheets (Electronic Worksheets) provide a rich environment for 

numerical calculation and the exploration of numerical models. These packages 

allow their users to set up calculations using formulas that are automatically 

updated when the relevant data in the spreadsheet changes. And formulas are 

easily constructed and edited as well. Adding to the power of the environment, 

spreadsheets provide a great many built-in functions to perform commonly used 

computations in the financial, statistical, and other problem domains. Once 

calculations are performed, spreadsheets offer the opportunity to explore graphical 

interpretations of the results through a number of built-in chart and graph types. 

These pictorial interpretations often provide insights into the meaning of a 

calculation that would otherwise be difficult to perceive or that may even go 

unnoticed. The particular spreadsheet we will learn about in this script is 

Microsoft Excel. However, modern spreadsheet packages are remarkably similar 

and what we learn about Excel will translate with little difficulty if we need to use 

Lotus 1-2-3, Quattro, or some other spreadsheet software. This unit will give you a 

basic introduction to Microsoft Excel. 

 

2.2 Objectives 
At the end of this unit students will be able to: 

 Understand the basic concepts of spreadsheets 

 Create, Save, Open and Close a workbook 

 Enter different types of Data in a worksheet 

 Edit data in cells and format worksheets 

 Sort, filter and parse data 

 Use in-built formulas and functions 

 Convert data into graphs and charts 

 Print the workbook 

2.3 Overview of Excel 
The Electronic version of "paper and Pencil workbook" is called a Worksheet and 

a three-dimensional stack of worksheets consisting of rows and columns forms an 

Excel Workbook. 

When we access Microsoft Excel for the first time, a worksheet similar to the one 

shown below is displayed. At the top of the screen is the File name indicator. 

This shows the name of the file that is in use at any moment, the default name 

being ‘Book1’ until it is changed by the user. Below the file name indicator is the 
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Menu bar, which contains a number of programmed facilities or commands like 

Opening, Creating, Saving, Manipulating a worksheet. Below the Menu bar are 

different types of Tool bars containing shortcuts for almost all the commands 

contained in various Menus in the menu bar. Below and to the left of toolbars is 

the Address bar showing the address of the active cell. To the right of the address 

bar is the Formula bar where the contents of a cell are displayed and we type our 

formulas and functions in this bar. 

Below this are shown the Column letters of the worksheet and then comes the 

actual worksheet in the form of grid lines showing cells, a Solid white cross 

showing the mouse pointer and a solid rectangular border showing the Active cell. 

Only when a cell is active can data be entered into it or its contents modified. To 

the left of the worksheet are shown the Row numbers. Vertical and Horizontal 

Scroll bars can also be seen to the right and below the actual worksheet. These are 

used to move up and down or left and right in a worksheet. To the left of the 

bottom scroll bar are the Sheet tabs used to select a particular sheet from the list. 

An active sheet is shown by the light background in the sheet tab. To the left of the 

sheet tabs are Sheet scroll bars that allow a user to display names of all the sheets 

in the workbook. 

Finally, at the bottom of the screen is the Status bar displaying various messages 

about the tasks being carried out in the worksheet. 
 

                   
 

In any worksheet rows are labeled by numbers (1, 2, 3, ...) and columns are 

labeled with letters (A, B, C, … , AA, AB, AC, ...). Cells are then labeled with 

both the column letter(s) and row number in that order. For example, the 

highlighted cell in the figure below is cell C4. A cell is selected (highlighted) by 

clicking the cursor over it. Only one cell can be selected at a given time and this 

cell is referred to as the active cell. 
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2.3.1. Entering data in the active cell and saving the file 
Remember that a worksheet cell is made active by clicking over it. Once this is 

done the cell is ready to accept data. In the figure below, we have selected cell C4 

as the active cell and then typed in the word "Sales." As we can see the word 

appears both in the cell itself and in the formula bar. If we want to edit (or erase 

and replace) this word later, we simply click over the cell, then move the cursor to 

the formula bar where it becomes the standard text editing I-beam pointer. Editing 

takes place in the formula bar and is reflected in the cell when we click the Check 

box to the left of the formula bar or press the Enter key. 

          

Once we have entered data into a worksheet, we can save the workbook in any of 

the following ways: 

1) Go to File-> Save/Save As, highlight the option and press Enter or Click the 

option 

2) Keep holding the ctrl key and press S 

3) Click the shortcut icon in the tool bar (floppy icon) 

In all these cases you will get a window asking for the file name, enter the proper 

name and press Enter or click the Save button and the file will be saved. 

To Close a file click the Cross icon at the top right corner of the sheet or choose 

File->Close from the Menu bar. 
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2.3.2 Entering text and numerical data in the worksheet 

If you closed the file at the end of the previous section after saving it then you 

need to open it before adding any new data or modifying the existing data in the 

file. The various ways of opening an existing file are given below: 

1) Go to File-> Open, highlight the option and press Enter or Click the option 

2) Keep holding the ctrl key and press O 

3) Click the shortcut icon in the tool bar (folder icon with an arrow) 

In all these cases you will get a window asking for the file name to be opened, 

enter the proper name and press Enter or click the Open button and the file will 

open. 

The following figure shows, after opening it, some text and numerical data entered 

into our example worksheet. Notice the blue line at the top of the figure which 

shows the name of our worksheet once we save it. The document has been saved 

and named Exp1 in the figure. 

When entering data in multiple cells, we usually employ a quicker method than 

selecting every new cell individually. The Enter key completes entry in a cell and 

moves the active cell to the cell immediately below the current cell. The Tab key 

has a similar effect but moves the new active cell to the cell to the immediate 

right. 

Let’s format the numerical data that has been entered in the cells which is of type 

currency. We will see the effect of this in the next figure. The spreadsheet will 

automatically keep track of whether the data we have entered is textual or 

numerical (it will assume text except when the first character is a digit, a decimal 

point, or one of the algebraic signs + or -). Formulas are a third category and these 

always begin with an equals (=) sign. The formatting and other operations 

available will then be appropriate to the type of the data entered. 
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2.3.3 Entering a formula to calculate a result in the worksheet 

The following figure illustrates the process of entering a formula to compute the 

total sales for all six months shown. To enter a formula, we begin with the = 

symbol. Then we enter an algebraic formula, using the cell names (B3, B4, etc. in 

our example) instead of the actual data entered in those cells. The effect is the 

same. The worksheet will substitute the values entered in those cells when it does 

the arithmetic. 

The advantage of this scheme is that whenever we change the numerical data in 

any of these cells, the formula is still valid. The worksheet will simply pick up the 

new values when it makes its substitutions for the cell names in the calculation. 

This simple scheme of symbolically representing data in our formulas rather than 

entering the actual data is a major benefit of using a spreadsheet. This is because 

we can repeat and/or correct calculations without retyping the formula that 

captures the basic computation. 
 

              
                 

2.3.4 Calculating with a formula 
The following figure illustrates the results of entering the above formula into cell 

B10. Notice that once we enter the formula, the result of the application of the 

formula appears in the cell and the formula itself appears in the formula bar. Once 

we check the results of the calculation in the cell itself, the formula can then be 

easily edited in the formula bar if necessary. 
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2.3.5 Altering the data used in a formula 
The following figure illustrates the results of entering new data into cell B4. 

Notice that the result of the application of the formula is automatically updated in 

cell B10 when this occurs. Alter some additional data and observe the results. 

     

 

2.4 Using Formulas for Excel Calculations 

2.4.1 Expanding Exp1 
Our previous worksheet (Exp1) computes the total sales for a six month period 

(see figure below). In this section we will expand this example to include sales 

from three separate sales regions and then compute 

 six-month totals for each region,  

 totals from all regions for each month, and  

 an overall total sales figure  

We begin by changing the column heading to reflect our intended addition of data 

for sales in three regions. To do this we simply click in the appropriate cell, then 

edit the text (see figure below).  
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Notice in the figure that we need to expand the available space for text in column 

B to accommodate the new label. To do that, we simply place the cursor at the 

boundary between column B and C in the column label row so that it becomes a 

double arrow icon. Then we just drag to the right to expand the column width. 
 

          
  

2.4.2 Adding additional data and expanding our six-month total 

formula 

The following figure shows more text and numerical data entered into our example 

worksheet. Now we wish to compute the six-month sales totals for Regions 2 and 

3. We could enter formulas in a way similar to the way we entered the formula to 

compute the total in column B. However, there is a much easier and less error-

prone way to accomplish this.  

Note that the formulas for cells C10 and D10 are very similar to the formula in cell 

B10. The calculation to be performed is the same except for the column in which it 

occurs. The spreadsheet makes it easy to exploit this similarity. We can simply 

duplicate the formula in cell B10 within cells C10 and D10, with appropriate 

changes to reflect the change in column. This process is called formula 

replication, and it is one of the most important and fundamental spreadsheet 

operations. 

To accomplish the required formula replication, we first select the cell where the 

formula resides, then drag to the right selecting the "target" cells and they get 

filled with the appropriate values. Another way is to select the source cell and 

target cells and with the appropriate cell selection kept active, we choose the 

Fill/Right commands under the Edit menu. This is illustrated in the figures below. 
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2.4.3 The replicated formulas 
The following figure illustrates the results of the formula replication described 

above. Cell D10 is selected there so you can observe the formula as it was 

"copied" to that cell. Notice that the basic structure of the formula is exactly the 

same as the original formula in cell B10, but the cell references have been 

changed to reflect the move from column B to column D. These changes in cell 

references are what makes such formula replication possible. The cell addresses in 

the original formula (= B3 + B4 + B5 + B6 + B7 + B8) are called relative 

addresses. This means that the formula in which they appear can be copied to 

another location with the new cell references having the same relative relationship 

to the new formula's home cell as did the original references to the original 

formula home cell. 

Hence when a formula is moved two cells to the right, all relative cell addresses in 

that formula will have their column label increased by two. If we moved a formula 

four cells downward, the relative cell addresses would have their row number 

increased by 4, and so on. 
 

                 
 



Computer Fundamentals 

 

Dr. Tariq Ahmad Page 10 
 

2.4.4 Summing monthly sales for all regions 
Now we'll add formulas to calculate the total monthly sales for all three regions. 

The following figure illustrates entering the appropriate formula for computing the 

total sales for January.  

               

Replicate the formula just entered in cell E3 to cells E4 through E8 by dragging 

the cell or highlight the source cell and destination cells and then use the 

Fill/Down command under the Edit menu to accomplish this. Now repeat this 

process to replicate the formula in cell D10 to cell E10 to compute the grand total 

of all sales (see figure below for final results). 

          

 

2.5 Using Excel's Built-in Functions  

2.5.1 Employing the SUM function to compute sales totals 
As our first example illustrating the use of an Excel built-in function, we will 

modify the Exp1 worksheet constructed previously. One of the built-in functions is 

the function SUM which, as its name suggests, computes sums of values in a range 

of cells. 

To do this, we delete the formula in cell B10, type an = sign, then select the 

function selection dialog box (the symbol fx) from the tool bar. The dialog box 

shown in the figure is then displayed and we can choose from among the many 

Excel built-in functions. In the figure, we have selected the SUM function from 
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the Most Recently Used function list. Once we make this selection we click to 

close the function selection dialog box. 
 

        

 
 

When we close the function selection dialog box, a second dialog box appears, as 

shown below. The purpose of this dialog box is to help us set the arguments for 

the function we've chosen. In this example, the spreadsheet presumes that we wish 

to sum the cells immediately above the formula cell. In other words it selects for 

us the range of cells B3:B9. This is almost correct. We probably don't care to 

include the empty cell B9, so we edit the range to read B3:B8, then click OK. 

The dialog box also has a brief explanation of what the function we've selected 

does and what its arguments stand for, and it even tells us what the result would be 

for the arguments it has pre-selected for us. 
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Once we adjust the arguments to be the range B3:B8 and click OK, we get the 

same result as we got earlier using formulas. We can now replicate the SUM 

function across the row to cells C10, D10, E10 as we did earlier. Now let's see 

how the SUM calculation differs from the previous calculation we made with the 

addition formula. 

2.5.2 Difference between SUM function and a formula using the + 

operator 

The SUM function is a convenient way to compute sums when we expect the 

amount of data in our spreadsheet to expand or contract in the future. The reason is 

that the SUM function automatically accounts for inserting and deleting data 

within the range of cells in its argument. The formula constructed with the + 

operator will not adjust for this accommodation. Let's modify our spreadsheet to 

illustrate this. Suppose for a moment we had a special clearance sale at the end of 

February and we now want to include these sales figures as a separate row in our 

data. It is easy to add more data in a spreadsheet by inserting rows or columns into 

the worksheet. 

The figure below shows how we would add a row after the February sales figure 

row. First we select the row before which we wish to insert a new row. We do this 

by clicking the row number at the right of the worksheet -- the entire row will be 

highlighted. Next we select the Rows choice from the Insert menu as shown in 

the figure. A new blank row will be inserted before the selected row. 
          

 
 

To complete our modification we add appropriate data to new row 5 (INR 10,000), 

as shown in the figure below. Now notice that the total for Region1 is 

automatically updated to include the additional INR 10,000 we just entered in cell 

B5. However, the total for Region 2 does not include the new amount in cell C5. 

The formula in cell C11 changes to keep exactly the same values in the sum as 

were there before the insertion of the new row. The new value is omitted 

altogether. The SUM function incorporates the new row as part of its new range. 
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Hence the SUM function and the + operator are adjusted in different ways for the 

insertion of new data. We added the new row just for the purpose of making this 

point. Let's delete it before proceeding. To do this we select row 5 again 

(remember, click the row number on the left side) and then select Delete from the 

Edit menu. 

As a final adjustment to the worksheet in this step, replicate the SUM function 

formula in cell B10 to cells C10, D10, and E10. 
 

 
 

2.5.3 Computing average sales per month for each region 
Now let’s add formulas to calculate the average monthly sales for all three regions. 

The following figure illustrates entering the appropriate formula for computing the 

Region1 monthly average. Note that we're employing a built-in function 

AVERAGE. If we know the function's name and purpose, we can simply type the 

formula. Or we could consult the function selection dialog box as we did for the 

SUM function earlier. 

In the figure below, we're entering the formula directly. The figure also illustrates 

that instead of typing in the range B3:B8, we can drag over that range of cells 

(note the dotted box surrounding the selected range) to indicate the range when the 

time comes for the function's argument to be entered in the formula. We would 

complete the formula shown below by typing in the closing right parenthesis and 

then clicking the green check mark to the left of the formula bar. Once the average 
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is computed for Region 1, we can replicate the formula to cells C12, D12, and E12 

to compute monthly average sales for the other regions and for the total monthly 

sales. 

         

 

2.5.4 Computing the standard deviation of the averages 
Let's suppose we wish to compute the standard deviation of the averages we 

calculated in the previous subsection. Follow the procedure given earlier and enter 

a formula employing the built-in function STDEV for computing the standard 

deviation for the Region1 monthly average (see figure below for any help).Now 

replicate the standard deviation calculation to cells C13, D13, and E13. The 

completed worksheet should have the following figures and function in cell B14 

should be similar to the one shown in the formula bar. 

           

 

2.5.5 An Example of Financial Arithmetic-Computing Car Payments 

In this section we will use an Excel built-in function that we didn’t talk about yet. 

Suppose you wish to compute the monthly payments you would have to pay on a 
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car you'd like to buy. Suppose the car costs 10,000 Dollars and you know you will 

have to pay a 10% annual interest rate for this amount. 

You'd like to do an analysis to decide what number of terms (pay-back time) you 

should try to get. Of course the longer the term, the lower your monthly payments 

- but the more interest you pay over the life of the loan. You want the shortest term 

for which you can comfortably pay the installments. Prepare a worksheet like the 

one shown in the figure to calculate the various payments for different terms (the 

file has been named installments).  

 
                

 

Excel has a built-in function for computing loan payments. It is called PMT and 

can be found in the financial function list as shown below. 

                            

The arguments for the PMT function hold the interest rate (Rate) for the period in 

which you're interested - a month in this case, the number of periods (Nper) you 

expect to pay, the present value (Pv) or amount of the loan, the future value (Fv) 

of the loan (this will be 0 if you intend to pay the loan off), and the type (Type) of 

payment to be made (this is 0 if your payments begin at the end of the month you 

get the loan; 1 if the payments begin immediately when you get the loan). The 

dialogue showing the arguments to the function is shown below. 
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The completed worksheet should have the following figures in it. The parentheses 

and red type face indicates that these numbers represent a payment (negative). 
 

                  
Similarly, you should wet your hands on other types of problems in finance, 

marketing, HR and other fields to gain more confidence in using Excel functions.                

2.6 Handling Data 
People in Marketing, Finance or HR need to handle large volumes of data. 
Handling data involves operations like sorting, filtering or parsing it. How we 
accomplish such tasks in Excel is the theme of this section. 
 
2.6.1 Sorting Data 
Data sorting is one of Excel’s most powerful features. Let’s take an example of 

hypothetical shares as shown in the figure below (file named share-sort).The data 

in the shares-sort file is unsorted. The column headers identify fields and the 

individual share names form records. Each field contains information on all 

records and each record has information on all the fields. 
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Before proceeding to sort data in the file, it seems pertinent to mention that Capital 

Gain is a continuous variable that measures the difference between selling price 

and the purchase price of the share expressed as a percentage of the purchase 

price. All such values for capital gain can be obtained by using the formula as 

                 ((selling price- purchase price)/purchase price)  

Which you can now easily work with (procedure discussed above in section 2.3), 

if you know the selling price of a share. 

A look at the data indicates that there are some shares with the same price. We 

now want to sort the shares in descending order (or Ascending) of share price. 

Since some shares have same price, we then use dividend to break the tie. Again, 

since some shares tie on both price and dividend, we use capital gain to sort the 

share prices, again in descending order. The steps to sort the data are as under: 

1) Select the area from A1 to D11 as the range to be sorted (including share names 

in sorting is important otherwise they will get detached from their field data 

values). 

2) With the range selected, choose Data and then Sort from the menu bar. A 

dialogue screen as shown below will appear. Shortcut icon on the toolbar can also 

be used. 

3) After choosing the values for various tabs and filling in the necessary 

information in the dialogue screen, press OK button and the data will be sorted. 
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The dialogue was created by clicking on the Sort By tab and selecting share price 

as the basis of the primary sort from the list of available fields. Accordingly 

fields for Secondary and tertiary sort were chosen respectively to break the tie 

between shares with same price and those with same dividend also. Since our 

range includes headers, we make sure that the Header Row box is checked. The 

sorted workbook is shown below and you can check the results of this three-way 

sort. 
   

                       
              

2.6.2 Filtering Data 
Filtering data is the process of selecting those records from a list that meet certain 

criteria desired by the user. It might be all employed people, or all female records 

and the like. For this purpose we now use the sorted shares-sort worksheet 

obtained in the above section. 

To start the filtering process we follow the steps given as under: 

1) Identify all field names to Excel by highlighting them. 
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2) With the fields selected, choose Data and then Filter and then AutoFilter from 

the menu bar. Upon doing this, four arrow tabs will be inserted to the cells 

containing the field names. 

3) To filter data, simply click on the arrow tab in the field that relates to the query 

that we want to answer (like for example, list all records where share price is 

greater than 1.2 and less than 10). 

4) Choose custom option from the drop down list, a dialogue as shown below will 

appear. 

 

        
 

5) Click on different tabs to obtain a list of different arithmetic operators, values 

and from the lists choose appropriate operators and values or fill in your own 

values for your query. 

6) Press Ok button and the data will be filtered. 
 

            
 

Notice that the arrow tab in B1 has turned from black to blue, indicating that it is a 

filtered list. The row numbers of the filtered records are also blue now. To restore 

the original list simply click on the blue arrow tab and select All from the drop 

down list. 

Remember that filtering can be done on two or more fields also. For example, if 

we want a list of all shares with more than 10% capital gain and with a dividend 

payment of more than 0.5. The same can be done by first choosing the capital gain 

tab and then the dividend tab and setting the appropriate values. 
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2.6.3 Parsing Data 
Sometimes researchers download data from Internet or import it from different 

sources. Mostly the data are not properly imported into Excel. The field columns 

of the original data are compressed into a single column. In simpler words, what 

appears to be three different columns in the source data, is imported as one single 

column containing each of the values separated by a space. In such situations 

Excel provides the Data-> Text to Columns command to redistribute data into 

separate columns. Let’s illustrate this with an example. We use the data contained 

in a word document as shown below in the figure. 
               

                     
 

We simple copy this selected text into an Excel worksheet as shown below. As can 

be seen, the text gets compressed into a single column in the sheet. 
  

        
 

To parse this data we select the column containing the compressed data. Then we 

choose Data from menu bar and then Text to columns. A dialogue screen appears 

as shown below.  
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As the data is separated by a space, so the wizard shows it to be Delimited (data 

can be of fixed width also). Pressing Next brings to the next dialogue that shows a 

list of delimiters where we choose the delimiter that best describes the separator 

that best describes our data separator. Pressing Next brings us to the final dialogue 

that gives us the choice to describe the format of our data. Once the proper format 

is chosen, we click Next and our data gets parsed into separate columns as shown 

in the next figure. 
 

 



Computer Fundamentals 

 

Dr. Tariq Ahmad Page 22 
 

 
 

                     
 

There is one more way of copying downloaded data from websites or other 

sources into Excel sheets with proper formatting. First we select the data from the 

source, say a web page, then copy it from there. Once we are in Excel, we choose 

Edit-> Paste special. The dialogue that appears gives us several different options 

like paste the text as HTML or Unicode text. 

2.7 Charts and Graphs in Excel 

There is a Chinese saying- A picture is worth thousand words. A chart or graph in 

Excel displays information in a precise and easy to understand form and conveys 
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things in a glance that could otherwise be conveyed using many pages or files. 

This section gives a basic know how about this feature of Microsoft Excel.  

2.7.1. Selecting data and constructing a chart 
Let's now chart the sales figures for each month for Sales Region1. We start by 

selecting the data appropriate for such a chart. Technically this data resides in 

column B, rows 3-8. However, we'd like to include the labeling already present in 

our worksheet, so we add column A and row 2 where the sales region is identified. 

So we select the range A2 through B8 and then choose the Chart command from 

the Insert menu to construct a chart as illustrated below. 
 

          

Excel has a chart wizard function to help in the construction of charts. The first 

chart wizard dialog box appears when we select the Insert/Chart command. This 

box is shown below. In this dialog box, we select the type of chart we wish to 

create. 
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Once we select the chart type and press the Next button, we get a second chart 

wizard dialog box, illustrated below for our example. In this box we can specify 

the range for our data. We also get a preview of the chart we're creating. Since we 

already preselected our data range, which is shown in this dialog box, we can just 

press the Next button here. 

 

In the next dialog box, we can change the preselected chart title if we choose and 

add our own X-axis and Y-axis labels. Notice that we have entered a label for each 

axis. These changes are reflected in the preview chart to the right of the dialog 

box. We can also add data table, gridlines or legends to the chart as is reflected by 

different tabs in the figure. Once we make the necessary changes, we press Next 

button once again. 

 

The final chart wizard dialog box asks us whether we wish to display the chart as 

an object (which we can resize and move around) in our current worksheet or 
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whether we'd prefer the chart to have its own worksheet. In either case, the chart is 

linked to data, meaning that when the data changes, the chart is automatically 

updated. We choose to display the chart as an object in our current worksheet. 

                       

Once we click Finish, our chart is displayed. We can drag it to adjust at any 

position and also resize it as needed. In addition, a Chart tool bar is displayed 

which allows us to adjust various features of the chart. 

 

2.7.2 Changing the chart type 
One of the most useful tools in the Chart tool bar is the Chart Type tool. The 

figure below shows it as a pull-down menu showing a variety of different chart 

types. Selecting one of these types changes the chart immediately to that chart 

type. 
 

              

 

The figure below shows the effect of choosing a pie chart type. Try some other 

chart types for this data. Some won't be very appropriate, but remember, you can 

switch to another chart type by selecting another choice from the pull-down Chart 

Type menu. In the figure we have used the Legends choice to display the legend at 

the right side. 
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2.7.3 Comparing Sales per Month for Various Regions 
There are a great many possibilities for charting and graphing in Excel. We have 

just begun to let the exploration for much more to start. The best way to learn 

about many of these is to experiment them yourself. In this section you will create 

a chart that allows sales for the different regions to be easily compared month by 

month. 

To get started, select the range of cells A2 through D8 to include sales data for all 

six months from all three regions. Then choose Chart from the Insert menu as we 

did before. This activates the chart wizard and gives you the first chart wizard 

dialog box, as shown below. Choose the column type chart. Continue with the 

chart wizard, supplying names for the chart title, X-axis, and Y-axis as shown in 

the third dialog box pictured below. 
 

                    

Remember that you can go Back in the chart wizard sequence if you forget to 

include a feature. You can also modify a chart once it is displayed in your 

worksheet as we saw earlier. Experiment to add some additional features of your 



Computer Fundamentals 

 

Dr. Tariq Ahmad Page 27 
 

own if you like. Try changing the chart type to see if you find a more convenient 

way to display the above data. 

2.8 Problem modeling and Decision making in Excel 
This section takes care of two important aspects of Excel viz. that of modeling 

verbal statements/problems into Excel form and of decision making. 
 

2.8.1 Problem modeling 
To use full mathematical modeling power of Excel, many more basic principles 

need to be understood. One such principle is the Decision making which will be 

briefly discussed in the next section after we learn to model the problems into 

Excel format in this section. One important thing to remember is that most 

modeling problems are phrased in terms of verbal and arithmetic statements that 

first need to be put in symbolic or algebraic form and later converted into an 

equivalent spreadsheet symbolic form. 

To put things in the proper perspective, let’s wet our hands with a practical 

problem. 

 

Suppose a store selling winter garments charges its customers a price of $p per 

unit. The store also offers a discount of d% of the value of any order if payment is 

made in cash. We are asked to calculate and send invoice to a customer who 

orders x units and pays in cash. 

 
To start calculating the invoice, we first need to put the problem in algebraic form, 

which is given below 
                  Value of the order = No. of units * price per unit 

 

                                                = x * $p = $px 

 

Discount offered = d% of the value of the order = d% of $px = d/100 * $px = 

$dpx/100 

 

                  Invoice = order value – Discount offered = $px - $dpx/100 

 

                  = $px(1-d/100) when the common term ($px) is factored out. 

 

This expression for the invoice is a completely general statement that adopts a 

specific numerical value once values are given for p, x and d. Now, before we can 

translate this algebraic expression into Excel form we need to design the same in a 

sheet shown as under (the sheet designed is also modeled for general problems). 
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In the example shown above, p=180, d=7% and x=2. The model displayed then 

calculates the invoice (334.8) based on the values of the variables. The example 

assumes that the payment is made in cash. Remember if any of the variables p, d, 

x are changed, the value for invoice generated will also change automatically. This 

is shown in the next figure for a set of 10 values. 

 

                                            
 

 The reason for the difficulty noted in the worksheet (#VALUE) is that Excel 

automatically carries out copying of formulas in a fully relative manner. This 

means that when the entry in B5 (=A5*B1*(1-B2/100)) is copied into B6 it 

becomes =A6*B2*(1-B3/100) and when it is copied into B7it becomes 

=A7*B3*(1-B4/100) and soon for other copies below A7. 

Although, this relative updating of column A cell is needed for 10 different values 

of x, it is not what we require for B1 and B2 cell references. They must always 

remain as B1 and B2 and must not update in the copying process. So what is the 

solution…….. 

The solution is what we call as ‘dollar-fixing’. Instead of writing B1 and B2 as 

the cell references for the price and the discount rate, we write B$1 and B$2 to 

keep them fixed with regard to their row numbers. This change to the formula in 

B5 is shown in the figure below. 
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2.8.2 Decision making 
Now, the question arises when payment is not made in cash, no discount should be 

offered. How to solve such a problem, the answer is Logical function IF that 

helps us make decisions based on fulfilling certain conditions. If is a pre-

programmed Excel statement or function that can make logical decisions of the 

True/False type. There are a number of logical functions in Excel but we will use 

only the If function here. 

In verbal form can be put as: 
 

                 =IF(condition, result if condition is true, result if condition is false) 

 

For our problem defined in the previous section, the verbal form can be as: 
 

             =IF(pay in cash, discount offered, discount not offered) 

 

Now, the concept involved should be clear and the verbal logic put into proper 

Excel format. To accomplish this we rephrase our worksheet to include the 

payment type (cash=1, other=0). Also in cell C3 enter the If statement which 

should be of the form: 
 
     =IF(B3=1, i.e. if payment is in cash, then B2 (pay the discount), else 0 i.e. zero discount 

rate) 

 

Now putting every thing right, the C3 cell entry will be as:  
 

                                       =IF(B3=1,B2,0) 

 

It is now clear that the C3 cell contains either of the two values-the discount rate 

fed in from B2 if payment is in cash or zero if it is not. 
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Lastly we have to modify the formula in B5  since it looks to B2 for discount rate, 

whereas now it should now look to C3 to find whether discount is to be offered or 

not. Consequently the contents of B5 cell will change from 
 

                      =A5*B$1*(1-B$2/100)     to   =A5*B$1*(1-C$3/100)  

 

Copying this formula into B6 to B14 generates the two modified worksheets, 

depending upon whether discount is offered or not (i.e. on the value contained in 

B3), shown below. 
 

                    

                                    

2.9 Printing in Excel  
Finally, when a document is prepared, we may need to have a hard copy of it for 

different purposes. How printing of worksheets is carried out will be discussed in 

the following sections. 

 
2.9.1 Setting page layout:  
It is used to view existing page layout or to set a new layout. To set a new layout, 

you can choose Page setup from File menu to 

display the page setup dialogue box. The 

dialogue box contains four tabs: Page, Margins, 

Header/Footer, and Sheet.                                  

 

Page tab Click on the page tab to make 

following changes to the layout.                    

 

1. Orientation: Select portrait or Landscape 

2. Scaling: Used to reduce or enlarge the print. 
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3. Paper size: Displays a drop down list to choose the required paper size. 

4. Print quality: Choose high or low resolution as needed. 

5. Page number: Enter the first page number to begin page numbering. 

6. Click OK to apply these settings. 

 

Margins tab Let’s you set the margin space between 

the edges of the page and the text on the four sides of 

the paper. It also allows you to set space for Header 

and Footer.  
 

Header/Footer tab To create standard and customized 

headers and footers, you can make use of header/ 

footer tab. 

To get a standard list of header and footer, click on the down arrow to the right of 

the header list box and footer list box. If you want to create a different 

(customized) header or footer then click on Custom header or Custom footer 

button to display the header or footer dialogue box. Fill 

in the three boxes to put text in the header or footer at 

the proper places. You can also add Date and Time to 

the header or footer by clicking on the respective icons.   

 

Sheet tab You can change the print range and elements 

to be printed such as headings, gridlines and comments 

and the order of pages in which the pages should be 

printed. The options available in this tab are: 

 

1. Print area: enter or select the area/range to be printed. 

2. Columns or rows to repeat: click appropriate icons to choose the rows to 

repeat at top and columns to repeat at left. 

3. Print elements: select the elements to print like 

gridlines, comments, row column headings etc. 

4. Page order: select any of the two options 

available there. 
 

2.9.2 Print preview  
Before printing the worksheet, you can review the 

appearance of the document on the screen. 

Previewing a document is a good way to identify 

formatting errors, such as incorrect margins, 

overlapping text etc. To view a document in print 

preview mode, choose Print preview from File 

menu or click the print preview icon on the 

standard toolbar. 
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2.9.3 Printing worksheet 
When you have completed formatting 

worksheets, you can print the whole sheet, part of 

the sheet or whole workbook. To print choose 

Print from File menu or click print icon on the 

standard tool bar. From the dialogue that appears 

choose the options that best suit your 

requirements to print. 
 

2.10 Exercise 
Q1. Answer the following in about 10-20 words. 

i) What is the indication that a cell is active? 

ii) When can data be entered to a cell? 

iii) Name various ways of making a cell active? 

iv) How many columns and rows are there in a worksheet? 

v) Where are the contents of an active cell displayed? 

vi) What is the easiest way of making the VI200 cell active? 

vii) What are the various ways of saving/opening a worksheet? 

viii) Name different types of graphs and charts in Excel? 

ix) How can we print only a selected part of a worksheet? 

x) Write steps for adding header/footer to a worksheet? 

Q2. Answer the following 

i) Enter some data to A1-A10 cells and do the following 

a) Format the range to bold underlined. 

b) Move the range to C1-C10. 

c) Draw a bar chart for the data. 

d) Delete part of the range. 

e) Undo the formatting done in a) above. 
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ii) In a new worksheet enter Sunday into cell A1 and then copy cell A1 

down to A7 and see the effect. 

iii) Use the copying facility to create the following series of numbers: 

                                      0,1,1,2,3,5,8,13,21 and so on. 

iv) Create a worksheet as shown and perform the following: 

 

                 
 

a) Calculate total marks obtained by Azhar using a formula. 

b) Copy the formula to get total marks for each student. 

c) Assuming that maximum marks for each subject are 100, calculate 

percentage of marks obtained by each student. 

d) Use in-built functions to calculate total marks for each student in 

column G. 

e) Use in-built function to find out the students getting maximum and 

minimum marks. 

f) Use appropriate chart type to represent the data in the sheet without 

the total column. 

g) In column H against each student record, assign a grade to each 

student based on some logical statement to be evaluated.  

2.11 Suggested Readings 
             1.  Introduction to Information Technology, ITLES, Pearson Education  

          2. Introduction to Computer Science, ITLES, Pearson Education 

          3. PC software for Windows made simple, Taxali, R.K, TMH Publications 

          4. MS Excel in easy steps, NCPUL New Delhi 


